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Introduction

With this guide, you will explore what you can do with the RSA306 USB spectrum analyzer. Applications range from
simple frequency / amplitude measurements of RF signals to real-time and modulation analysis that provide you with
a complete system view of your device under test.
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Check list for the demo
Before beginning the demo, please be sure you have the following items:

Item Illustration
RSA306 USB spectrum analyzer

RTSA demo board
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Item Illustration
USB Y-cable (to power the board)

N-BNC adapter

Whip antenna
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Item Illustration
BNC cable

USB 3.0 cable
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Demo guide overview

Fundamental operations of spectrum analyzers
The Tektronix RSA306 USB Signal Analyzers have the ability to perform basic spectrum measurements that most
Spectrum Analyzer users are already accustomed to. The goal of this part is to demonstrate that the instrument has
these basic spectrum analyzer capabilities.

■ Demo 1: Basic spectrum measurements with markers
■ Demo 2: Power measurements with markers
■ Demo 3: Traces and detectors
■ Demo 4: Save and recall

 Introduction

RSA306 Self-Guided Demo 5



Real-time DPX
Two of the most challenging types of signals to identify and capture are low-level signals close to your signal
frequency and rarely-occurring transients. Sometimes the interference is so infrequent that you can’t detect it at all.
You suspect it is there because of seemingly-random errors. DPX Spectrum instantly demystifies these situations by
displaying a clear image of the offending signals. Its capture probability is 100% for transients as short as 100 μsec.

■ Demo 5: DPX and transient capture
■ Demo 6: Transient capture: Mask test and act on violation

Modulation
Digital modulation is used in virtually all modern communication systems. These systems have penetrated every
aspect of our lives at a rapid pace. The growth has put increased stress on the ability to quickly and efficiently
analyze a wide variety of digital modulation schemes. In some cases, general modulation schemes have been
included in complex standards with rigorous specifications involving manual test procedures according to these
standards that require lengthy test setups with skilled engineers. Analog modulation is the most fundamental
modulation method, and is frequently used to demonstrate principles in education labs.

■ Demo 7: Analog modulation analysis
■ Demo 8: Digital modulation analysis
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EMI spurious search
From the first wireless transmissions, electromagnetic interference (EMI) has been a concern for design engineers.
General-purpose spectrum analyzers that contain appropriate filters and detectors are often employed in diagnostics
and pre-compliance, as they are fast measurement tools that often are already used in the design process and do not
require additional capital expense.

■ Demo 9: EMI spurious

Over-the-air demo
This part shows how to use the RSA306 in off-air applications. Using the whip antenna provided with the RSA306
demonstration kit, you can demodulate and listen to the signals from the local FM broadcasting station, see the
realtime spectrum of the signals in the ISM band created by your smart phone, and use the RSA306 in interference-
hunting.

■ Demo 10: FM listening
■ Demo 11: ISM band DPX
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Setup
As with any test, one of the first steps is to connect the instrument to the device under test. For the initial exploration,
a demo board has been provided to output signals needed for the demo. After you’ve completed the demo and have
gained an understanding of how the RSA306 operates, connect to your own system and see how the RSA306 can
help in your day-to-day work.

1. Install SignalVu-PC
■ Install the SignalVu-PC software onto your PC. You can download the software from www.tektronix.com/

downloads, or it is available on the flash drive that is provided with the RSA306.

2. Set up the RSA306
■ Power the RSA306 by connecting the USB 3.0 cable to the USB 3.0 port of your PC.
■ Install the N-BNC adaptor on RSA306.

3. Setup the demo board
■ Connect one end of the USB Y-Cable to the demo board.
■ Connect the other end of the USB Y-Cable to 2 USB ports either on your PC or a separate USB power

supply.
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4. Connect the RSA306 to the demo board
■ Connect one end of the BNC cable to the RF port of the RSA306.
■ Connect the other end of the BNC cable to the RF port of the board.

 Introduction
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SetUpDiagram

2

3

4
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Demo instructions

Demo 1: Basic spectrum measurements with markers
When using a spectrum analyzer, one of the first settings is that of the frequency. In this demonstration, we will use
markers to locate the CW signal generated from the demo board, and set the appropriate frequency for the
measurement.
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Instructions for the demo board 

1. Press the On button to turn on the
demo board.

2. Set the reference to INT (internal
reference).

3. Set the run mode to FREE RUN.

4. Click the ROW and COLUMN buttons
to select CW as the signal to
generate.

demoboard1

1

234
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Instructions for the RSA306 

1. Double click the SignalVu-PC icon on
the PC desktop to start the
application.

screenicon

1

2. Click Live Link on the menu bar to
view the drop down menu. Click
Search for Instrument.

A notification will briefly appear
stating that the instrument was
found. 

3. Click Connect To Instrument. Select
RSA306@USB USB::0. First-time
connection to the analyzer may take
up to 10 seconds.

rsaconnect

2 3
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4. A Connect Status dialog box will
appear to confirm the instrument is
connected. Click OK.

TIP. You can quickly verify
connection status by looking at the
connection indicator square on the
menu bar. It is green ( ) when an
instrument is connected. It is red ( )
when it is not. You can also view the
name of the instrument that is
connected by hovering the mouse
indicator over the .

rsaok

4

Demo instructions  

14  RSA306 Self-Guided Demo



5. Click the Preset button.

preset

5

6. Click the settings button to display the
settings control panel.

topleft

6

7. Click Max Span to set the Span to the
maximum value.

maxspan

7
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8. Right click the screen, and select
Marker to peak.

TIP. Right Click on Tablet

Touch the screen where you want to
right-click, hold until a complete
square appears, and then lift your
finger. The shortcut menu appears
after you lift your finger.
 

 

markertopeak

8

Demo instructions  

16  RSA306 Self-Guided Demo



For Tablet users 

Activate the on-screen numeric entry of
values and Up/Down controls by selecting
View: Numeric Keypad. 

When the Numeric Keypad view is
activated, up/down arrows and a numeric
keypad icon will pop up whenever a field
requiring input is selected. 
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Selecting the 'calculator' numeric keypad
icon will pop up a numeric entry box. 

9. Click To Center in the bottom marker
setting area. This sets the center
frequency of the analyzer to the
center of the signal.

tocenter1

9
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10. Set the Span to 40 MHz.

setspan

10

11. Click Peak.

12. Click To Center again.

tocenter2

12 11
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13. Right click the screen, and select Add
marker.

addmarker

13

14. Drag the new marker M1 to the noise level. Notice that readouts show:

■ The amplitude and the frequency of the reference marker (MR).
■ The amplitude and the frequency of the selected marker (M1).
■ The difference (ΔM1) between the selected marker position and the position of the reference marker.
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Demo1-Step13

141414
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TIP. Undo, Redo, and Recall

You can undo anything you do with this  control.

If you are having trouble with this step, recall the setting Demo1_CW.tiq from the directory C:/SignalVu-PC
Files/Example Files. This will give you the correct amplitude, frequency, span and marker settings
automatically. This file also contains data collected from a previous test and creates a trace on screen of the result.
Press Run to clear this data and take results from your instrument.
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15. Set the RBW to 30 kHz. The RBW
setting is located at the left side of the
spectrum display.

TIP. RBW

The resolution bandwidth (RBW)
determines the fast Fourier transform
(FFT) bin size, or the smallest
frequency that can be resolved.
Smaller RBW improves the
selectivity, but degrades the sweep
speed and the trace update rate. rbw

15
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16. Select Options from the Tools menu.

17. Under the Prefs tab, set the Color
Scheme to Blizzard.

blizzard

16 17
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TIP. Ink Saver Mode

You can print screen images with a white
background. Selecting the scheme color
to Blizzard makes the background color
changes from black to white in the graphs.

 Demo1Step16Note
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Demo 2: Power measurements with markers
Integrated power between markers is an easy way to measure the power of a modulated signal without setting up a
channel power measurement. SignalVu-PC performs integrated power and power density measurements using
power markers. When measuring signal density, the signal is assumed to be noise like, and measurements are
corrected to a 1 Hz bandwidth. Selecting power measurement markers automatically switches the trace detector to
Ave (RMS) for accurate results. Integrated power between markers is an easy way to measure the power of a
modulated signal without setting up a dedicated channel power measurement.

Instructions for the demo board 

1. Keep the same setting as the last
demo. Use the ROW and COLUMN
buttons to change the signal type
from CW to OFDM.

odfm

1
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Instructions for the RSA306 

1. Keep the same setting as the last demo, or recall the setting Demo1_CW.tiq. Click the Stop button to pause
the measurement.

2. Drag the marker reference (MR) on left side, and marker 1 (M1) on right side of the OFDM spectrum.

3. Click the Define button in the Marker settings.

4. Within the Marker Properties tab, in the Readouts dropdown box, select Power.

TIP. You can measure phase noise by setting the delta marker to dBc/Hz.

Advanced channel power measurement and ACLR (adjacent channel leakage power ratio) measurement can
be done in “Chan Pwr and ACPR” display.
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3330Demo2Trace

1

22

3

4
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Demo 3: Traces and detectors
This demo familiarizes you with the trace detection and function controls available in SignalVu-PC used with the
RSA306.

Instructions for the demo board 

1. Keep the same setting (OFDM signal)
as the last demo.

Demo3OFDM

1

Instructions for the RSA306 

1. Keep the same setting, or recall the
setting Demo2_OFDM_marker.tiq.
Click Run.

Demo3Step1

1
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2. Right click the screen, and select All
markers off.

Demo3Step2

2

3. Click the settings button to display the
Settings control panel.

Demo3Step3

3
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4. In the Traces tab, select Trace 1, and
then set Detection to Avg (VRMS)
and Function to Avg (VRMS).

Demo3Step4

4

5. Select Trace 2, and then set
Detection to +Peak, Function to Max
Hold, and enable Show.

Demo3Step5

5
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6. Select the trace to Trace 3, select
Detection to -Peak, Function to Min
Hold, and enable Show.

Demo3Steps

6
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TIP. Trace detectors process the data underlying the trace to provide the results you need depending upon your
application. Available detection methods are +Peak, -Peak, Avg (VRMS), Sample, and CISPR Pk.

Trace functions are applied to multiple traces as they are displayed. Available settings are Normal, Average, Max
Hold, and Min Hold. The Number of Traces setting specifies how many traces are averaged.

The same selections are available in the upper left display selection and mouse-over dropdowns.
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The results show the three difference traces displayed in the screen at the same time.

■ The Average trace is generated by multiple traces averaged together. There is one vertical value for each
underlying frequency data point. Once the specified number of traces have been acquired and averaged to
generate the displayed trace, each new trace takes the place of the oldest trace in the calculation.

■ Max Hold trace displays the maximum value in the trace record for each display point. Each new trace display
point is compared to the previous maximum value and the greater value is retained for display and subsequent
comparisons.

■ Min Hold trace displays the minimum value in the trace record for each display point. Each new trace display
point is compared to the previous minimum value and the lesser value is retained for display and subsequent
comparisons.
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TIP. Right-click action menu. You can change marker settings and how waveforms are displayed by using the right-
click Actions menu.

Select Selects markers and adjusts their position.
Span zoom Zooms the graph area about the selected point. Right-click in the graph display at a point of interest and

drag to increase or decrease the span about the point of interest. Span zoom adjusts the span control.
CF pan Adjusts the center frequency according to horizontal movement.
Zoom Adjusts the horizontal and vertical scale of the graph. The first direction with enough movement becomes

the primary scale of adjustment. Adjustment in the secondary direction does not occur until a threshold of
30 pixels of movement is crossed. Dragging to the left or down zooms out and displays a smaller waveform
(increases the scale value). Dragging to the right or up zooms in and displays a larger waveform (decreases
the scale value).

Pan Adjusts the horizontal and vertical position of the waveform. The first direction with enough movement
becomes the primary direction of movement. Movement in the secondary direction does not occur until a
threshold of 30 pixels of movement is crossed.

Marker to peak Moves the selected marker to the highest peak. If no marker is turned on, this control automatically adds a
marker.

Add marker Defines a new marker located at the horizontal center of the graph.
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Demo 4: Save and recall
In SignalVu-PC, you can save different types of data for later recall and analysis.

Instructions for the demo board 

1. Keep the same setting (OFDM signal)
as the last demo. Demo3OFDM

1

Instructions for the RSA306 

1. Keep the same setting, or recall the
setting Demo3_OFDM_trace.tiq.
Select Save As from the File menu to
open the Save As dialog box.

Demo4-1

1
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2. Navigate to the folder where you want
to save the setups, or use the default
location. Enter a file name. Select the
type of file to Acq data with setup
(TIQ)(*.tiq).

Demo4-2

2

3. Click save.

Demo4-3

3
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4. Click the Preset button.

Demo4-4actual

4

5. Select Recall from the File menu to
open the Open dialog box. Navigate
to the folder containing the file you
want to recall. Select the .tiq file you
just saved to recall, and click the
Open icon .
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TIP. File formats you can use to save files

Setup files (Setup) Saves all of the setup information for all displays.
Screen shot (PNG/JPG/
BMP)

Saves a capture of the screen in the specified format.

Results Export files (CSV) Saves the trace and numeric data for the selected display. The trace and numeric data are saved
as CSV files.

Measurement Settings
(TXT)

Saves a list of settings relevant to the selected measurement to a text file. This option is useful for
including the measurement settings in reports.

Trace (Various) Saves a trace for later recall into the display from which it was saved.
Data (TIQ/CSV/MAT) Saves data and measurement setup for analysis later (TIQ format) or as data to use with external

software in either CSV (comma-separated value) or MAT (MATLAB) formats.
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Demo 5: DPX and transient capture
The DPX display helps you to see how traces change over time and displays signal events that cannot be seen on a
swept spectrum analyzer. DPX Spectrum indicates how traces change in two ways. First, it uses color shading to
show how consistent the shape of a trace is. Second, it uses persistence to hold signals on the screen so you can
see them longer. The DPX display reveals transient signal behavior that helps you discover instability, glitches, and
interference.

Instructions for the demo board 

1. Keep the same setting as the last
demo. Use the ROW and COLUMN
buttons to change the signal from
OFDM to Inf Hop (Infrequent hopping
signals).

Demo5InfHop

1
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Instructions for the RSA306 

1. Keep the same setting, or recall the
setting Demo3_OFDM_trace.tiq. Click
the Display icon.

Demo5-Step01

1
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2. In General Signal Viewing, select
DPX from the Available displays box.

3. Click the Add button (or double-click
the DPX icon). This will add the DPX
icon to the Selected Displays box.

4. Click the OK button.

Demo5-Steps2-4

2

3

4
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5. In the DPX display, set the CF to
2.4453 GHz and the Span to 40 MHz.

Demo5-First5Steps

5

6. Select the Split view.

You can see the hopping signals displayed in the DPX spectrum, and compare it in the standard spectrum
display on the right side. Note that the standard spectrum display nearly or always misses the transient
signal. 
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Demo5-Step6

6
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7. Select the DPX display by clicking
anywhere on it with the mouse, and
click the settings button.

TIP. Changing the color scheme

In the “temperature” palette, the
highest color (Maximum) is deep red
and the lowest (Minimum) is dark
blue. Values between Maximum and
Minimum are represented by the
other colors of the palette.

 

Demo3Step7

7
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8. Under the Bitmap Scale tab, set the
Max scale to 3% for the DPX
Spectrum display.

Demo5-Step8

8

9. Under the Ampl Scale tab, set the Min
color scale to -80 dBm for the
DPXogram display.

Demo5-Step9

9
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10. Under the Prefs tab, enable Show
parameter readouts.

Demo5-Step10

10

11. Click Stop to pause the measurement. Right click the DPXogram screen, select Add marker, and drag the
marker to one hopping signal. Then add another marker and drag it to the closest hopping signal. The delta
marker will show the time between two hopping signals is about 1.25 s, or the hop occurs every 1.25 second.

12. You can set the size of the DPX spectrogram by selecting the divider bar between the displays and moving it
up or down to add area to the display of interest.
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Demo5-Step11-12

1112
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TIP. 100% POI

The minimum event duration required to ensure 100% Probability of Intercept (POI) or event capture. It depends on
interaction between span, RBW, and FFT length. You can use the POI time value to determine if you are at risk of
either missing a narrow transient or of its captured amplitude being less than the actual signal. The minimum 100%
POI for RSA306 is 100 μs.
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Demo 6: Transient capture - Mask test and act on violation
The mask test feature in SignalVu-PC allows you to save events of interest automatically and allows you to save an
acquisition file in an open data format and/or a screen capture when a signal in the frequency domain violates the
mask.

Instructions for the demo board 

1. Keep the same setting (Infrequent
hopping signals) as the last demo.

Demo6-InfHop

1

Instructions for the RSA306 

1. Keep the same setting, or recall the
setting Demo5_DPX.tiq. Click Run.

Demo6-1

1
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2. Under the Tools menu, click Mask
Test….

Demo6-step02

2

3. Select DPX: Trace1 from Search in:.

4. Select is outside mask from Test for:.

5. Click Edit limits… to open the Mask
Test Editor.

Demo6-3-4-5

3
5

4
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6. In the Mask Test Editor, select the DPX Trace1 as the Reference.

7. Click Auto Draw to generate a mask automatically adjusted to the Reference.

8. Click Done.

TIP. Mask Test Editor
■ The margins between the mask and the reference trace can be specified by X Margin and Y Margin.
■ The points can be added, edited, or deleted.
■ You can also create a Frequency Mask by using the manual method.
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Demo6-6-7-8

6

7

8
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9. In the DPX display, and click the
settings button.

Demo6-9

9

10. Select Trace1 as the Trace under the
Traces tab.

Demo6-10

10

 Demo instructions

RSA306 Self-Guided Demo 55



11. Under Tools, click Mask Test….

Demo6-step11

11

12. Under the Actions tab, select Beep, Save acquisition data, Save trace, and Save picture.

13. Click Enable Test.

When a mask violation is detected, the system will sound a beep, and save all your selected format of files
into the selected folder automatically.
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TIP. Actions for violations
■ The analyzer can take up to five actions when a match occurs. In Run mode, the analyzer can sound a

beep, stop acquisitions, save acquisition data, save trace data, and save a picture of the display. In
Replay mode, it can sound a beep and stop analyzing.

■ Files can be saved in the native format of SignalVu-PC (.tiq), or in comma separated variable (.CSV) or
Matlab level 5 (.MAT) formats.

■ The folder for saving files can be selected from Save as….
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Demo6-12-13

12

13
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Demo 7: Analog modulation analysis
Analog modulation is the most fundamental modulation method. The analog modulation analysis feature in the
RSA306 series provides measurements to demodulate and analyze amplitude modulation (AM), frequency
modulation (FM), and phase modulation (PM). This example shows how to analyze an FM signal with the RSA306.

Instructions for the demo board 

1. Keep the same setting as the last
demo. Use the ROW and COLUMN
buttons to change the signal type
from Inf Hop to FM (frequency
modulation signals).

Demo7-FM

1

Instructions for the RSA306 

1. Click the Preset button.

Demo7-1

1
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2. Click the Display button.

Demo7-Step2

2
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3. In General Signal Viewing, select
DPX from the Available displays box.

4. Click the Add button. This will add the
DPX icon to the Selected Displays
box (and remove it from the Available
displays box).

Demo7_Steps3-4

3

4
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5. In Analog Modulation, select FM from
the Available displays box.

6. Click the Add button.

7. Click the OK button.

TIP. Selecting displays
■ You can also double-click the

desired display to add or remove
it.

■ Five application presets are
available for the display
selection.

Demo7_5-6-7

5

6

7
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8. Select the DPX display by clicking
anywhere on it with the mouse, and
set the CF to 2.445315 GHz and the
Span to 500 kHz.

Demo7-Steps3-8

8

9. Click the Analysis control button.

Demo7-9

9
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10. Under the Analysis Time tab, set the
Analysis Length to 10 ms.

Demo7-10

10

11. Click the FM display, and then click
the settings button.

Demo7-11

11
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12. Under the Parameters tab, set the
Measurement BW to 200 kHz.

Demo7-12

12

NOTE. FM measurements readout
■ +Pk: positive frequency deviation
■ –Pk: negative frequency deviation
■ RMS: RMS value of the deviation
■ Pk-Pk: peak-to-peak frequency deviation
■ Pk-Pk/2: peak-to-peak frequency deviation divided by two
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Demo 8: Digital modulation analysis
The General Purpose Digital Modulation Analysis provides vector signal analyzer functionality. A wide variety of
modulation types are supported, allowing you to view your signals in Constellation, Eye and Trellis diagrams,
measure the quality of the modulation, display time-domain waveforms for demodulated I & Q signals, EVM, Phase
Error, Magnitude Error, and more. This example shows how to demodulate a QPSK signal with RSA306. This
demonstration also introduces the concept of application presets to quickly set up for complex analysis tasks. This
demonstration relies on the optional modulation analysis capabilities of SignalVu-PC. If you are using a basic version
of SignalVu-PC, a trial license for this analysis can be accessed through the Tools: Manage Licenses menu of the
software.

Instructions for the demo board 

1. Use the ROW and COLUMN buttons
to change the signal type from FM to
QPSK1.

Demo8-QPSK

1
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Instructions for the RSA306 

1. In the Presets menu, click application.

Step1

1

Demo instructions  

68  RSA306 Self-Guided Demo



2. Select Modulation Analysis for the
Preset.

Step2

2

3. Click OK.

Step3

3
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4. Click the DPX display, set the CF to
2.445315 GHz and the Span to
10 MHz.

TIP. Save as application presets

To save setups so that they appear in
the Application Presets window, save
your setup in the folder C:\SignalVu-
PC Files\User Presets. The saved
setup will appear in the Application
Presets window with the name you
give the file.

Step4

4
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5. Click the Constellation display, and
then click the settings button.

Step5

5

6. Under the Modulation Params tab,
Select QPSK from the Modulation
Type list, set the Symbol Rate to
3.072 MHz, set Measurement Filter to
Root raised cosine, Reference Filter
to Raised cosine, and Filter
parameter to 0.35.

Step6

6
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TIP. Modulation filters

In most modulation schemes, signals are filtered to reduce the bandwidth prior to transmission. When the signal
under test has been passed through a modulation filter, a matching Measurement Filter should be selected in the
instrument in order to interpret symbols properly. The Reference Filter, while not used for demodulation, is
important for making the proper error vector measurement calculations. This filter will normally be defined by the
modulation/demodulation standard.

 

7. Click the Stop button.

Step7

7
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8. Select the Symbol Table, right click
the screen, and select Add Marker.

Step8

1

9. Drag the marker to any cell in the Symbol Table. This sets the marker (MR) time value to the starting time for
the cell containing the marker.

10. Look for MR in the Constellation graph. Move the marker to different cells in the Symbol Table.
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TIP. Symbol table

Each symbol value is assigned a position in the Constellation diagram. The Symbol Table will be used to
demonstrate the mapping between quadrants in the Constellation diagram and the symbol values.

TIP. Correlated display

Not only are all the displays correlated through the shared data set, but the markers, which are inherently
correlated, make it very easy to see how a data point in one domain relates to a specific data point in any
other. This can greatly reduce troubleshooting time.
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Demo8-QPSK

9
10
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Demo 9: EMI spurious
The spurious measurement in the RSA306 is set up to change limits vs. frequency, and antenna correction factors
can be applied. Violations above the user-set limits are shown in red on the table. This example shows how to use
the spurious display in SignalVu-PC and the RSA306 to perform EMI pre-compliance and diagnostics.

Instructions for the demo board 

1. Keep the same setting as the last
demo. Use the ROW and COLUMN
buttons to change the signal type
from QPSK1 back to CW.

Demo9CW

1

Instructions for the RSA306 

1. Click Preset.

Demo9-Step1

1
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2. Click the Display button.

Demo9-Step2

2
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3. In RF Measurement, select Spurious
from the Available displays box.

4. Click Add to add the application to the
Selected Displays list.

5. Select the Spectrum icon in the
Selected Displays list.

6. Click Remove to clear the icon from
the list.

7. Click OK.

Demo9-Steps3-7

3

4
5

6

7
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8. Click the settings button.

Demo9-Step8

8

9. In the Scale tab, select the Log scale
to reset the display to show the
frequency axis in a logarithmic scale.

Demo9-Step9

9
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TIP. Loss correction

The External Gain/Loss Correction tab

under the amplitude control panel ( )
allows you to apply a correction to a signal
to compensate for the use of external
equipment, such as an amplifier or
attenuator. External loss tables can be
used to apply a frequency dependent
gain/loss correction to the signal.

 

10. Under the Ranges and Limits tab,
click Load to select the appropriate
limit line and measurement condition.

11. Select FCC Part 15, Rad, Class A
(10m).csv for this example.

Demo9-Steps10-12

10

11

12
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12. A larger new resized window of range
and limit table can be displayed by
clicking Expand.

You can edit the start and stop range, filter shape, RBW, VBW, detector, threshold and excursion, and limit line.
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After loading the spurious table, your display should look similar to the picture below. The green bar is the loaded
limit line as standards suggest.
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Demo 10: FM listening (Demo board not needed)
The RSA306 Series USB Spectrum Analyzers can demodulate audio signals, which can help you to identify unknown
radio signals. You access the Audio Demod tab from the Settings control panel of the DPX Spectrum plot display.
This Demo shows how to use the RSA306 to demodulate the local FM radio signals and listen to the programming.

Instructions for the antenna 

1. Unplug the BNC cable from the
RSA306, and connect the provided
whip antenna to the RSA306 input.

Demo10Antenna

1
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Instructions for the RSA306 

1. Click the Preset button.

2. In the Spectrum display, set the CF to
97.75 MHz and the Span to
20.5 MHz.

TIP. FM broadcasting

Throughout the world, the FM
broadcast band falls within the VHF
part of the radio spectrum. Usually
the FM band starts from 87.5 MHz to
108.0 MHz. (The frequency
modulation radio broadcast band in
Japan is 76-90 MHz.)

3. Set the RefLev to -30 dBm.

Demo10-Steps1-5

1

3

2
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4. Right click the screen, and click
Marker to peak.

5. Click To Center in the bottom marker
setting area. This sets the center
frequency of the analyzer to the
center of the signal.

Demo10-Steps4-5

4

5
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6. In the Setup menu, click Audio.

TIP. Audio on DPX

Audio Demodulation is also available
when DPX display is running, but the
sound quality may be degraded
depending on the processer of the
host PC.

Demo10-Step6

6

7. Select FM – 200 kHz as the demodulation.

8. Click Run to start listening to the FM radio signal.

9. Adjust the Audio Gain setting so you can hear the demodulated signal. The sound level is also affected by the
setting of the Windows volume control.

10. Click the Browse… button to select the location you want to save the steam file.
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11. Enable the Activate button to start saving the audio, and disable the activate button when you want to stop
saving. The saved audio format is .wav, which can be played by Windows media player in your PC.

The screenshot below shows the RSA306 is tuned to 91.5 MHz center frequency to listen the local FM
broadcasting. Drag the marker to other spectrum peaks, center the peaks, and listen to the programming at
other channels. 
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Demo10-Steps7-11

7

8
9

10

11
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Demo 11: ISM band DPX (Demo board not needed)
The real time streaming of the RSA306 combined with the DPX processing of the SignalVu-PC software is designed
to address the measurement challenges associated with dynamic RF signals such as the bursted packet
transmissions of WLAN and Bluetooth. Combo devices that use both Bluetooth and 802.11b/g/n WLAN networks
have a unique set of RF interference problems because they share the same 2.4 GHz Industrial/Scientific/Medical
(ISM) frequency band. In this example, we will explore this real-world problem using a whip antenna. The
demonstration relies on WLAN and Bluetooth signals from a tablet, phone or PC that you can control On or Off.

Instructions for the antenna 

1. Keep the whip antenna attached to
the RF input on the demo board as in
the last example.

Demo11Antenna

1
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Instructions for the RSA306 

1. Click the Preset button.

2. Click the Display button.

Demo11-Steps1-2

1

2
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3. In General Signal Viewing, select
DPX from the Available displays box.

4. Click the Add button. This will add the
DPX icon to the Selected Displays
box (and remove it from the Available
displays box).

5. Click the OK button.

Demo11-Steps3-6

3

4

5
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6. In the DPX display, set the CF to
2462 MHz or to the center frequency
of one of the WLAN channels. Set the
Span to 40 MHz. See the tip below.

TIP. 2.4 GHz WLAN channels

There are 14 channels designated in
the 2.4 GHz range (2400–
2483.5 MHz) spaced 5 MHz apart.
Channels 1 (2412 MHz),
6 (2437 MHz), and 11 (2462 MHz)
are the most common channels to
choose, and most routers will use one
of them as the default channel.

 

Demo11-Step6

6
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7. Select the Split view.

Demo11-Step7

7

8. Set the RefLev to -40 dBm.

Demo11-Step8

8

9. In the DPX display, and click the
settings button.

Demo11-Step9

9
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10. Under the Bitmap Scale tab, set the
Max scale to 3% for the DPX
Spectrum Display.

Demo11-Step10

10
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11. Under the Ampl Scale tab, set the
Max color scale to -40 dBm for the
DPXogram Display.

Demo11-Step11

11
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12. In the Traces tab, set the Dot
Persistence to Infinite.

Demo11-Step12

12
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13. Turn the WLAN function Off, then On
in your smart phone/tablet/PC while
monitoring with the setup above.

Check the DPX display to see if you
can see the spectrum of the WLAN
signals. If no signal, you can change
the center frequency of the RSA306
to other channels. 

Demo11-Step13

13
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TIP. DPX persistence

You can set the Dot Persistence to be Variable or Infinite.

■ In variable persistence mode, you specify a decay period that limits how long a point will be displayed.
■ In infinite persistence mode, once a point in the display has been written to, it will remain visible indefinitely.

We start with infinite persistence because it ensures that all transients are kept on screen.
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TIP. Wi-Fi test mode

To better observe the WLAN activities in
the DPX display, you can cause both
uplink and downlink activity on your device
by navigating to an “internet speed
testing” webpage to test both the
uploading and downloading speed, and
monitor the DPX display of the RSA306 at
the same time.
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14. Turn the Bluetooth function Off, then
On in your smart phone/tablet/PC
while monitoring with the setup
above.

Demo11-Step14

14
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15. Click Stop to stop the acquisitions
when you have a pattern on the
spectrogram you would like to
examine.

Demo11-Step15

15

16. Right click the display, and click Add
markers twice to add two markers.
Then you can measure the distance
between hops in frequency and time
using the markers on the
spectrogram.

Demo11-Step16

16
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The following screen shot shows the real time display in the RSA306. You can see a typical WLAN interchange
between a nearby smart phone/tablet/PC and a more-distant network access point (AP). The smart phone/tablet/PC
signal is nearly 30 dB stronger than the AP's signal because it is closer to the measurement antenna. At the same
screen, you can also see the Bluetooth signals, and even the measurements of the time and frequency intervals
between those hop signals.
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